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Introduction

Preface

Thank you for using FISAP for Windows for your electronic FISAP processing
needs. The U.S. Department of Education (ED) uses the information that you provide
in the Fiscal Operations Report and Application to Participate to determine the
amount of funds you will receive for each program.

FISAP for Windows is a PC software package provided to you by ED. It contains the
Fiscal Operations Report for program participation during the Award Year July 1,
1997 through June 30, 1998. Federal regulations state that if you spent fundsin
1997-1998 or have a Federal Perkins Loan Fund, you must submit a Fiscal
Operations Report.

It also contains the Application to Participate for the Award Year July 1, 1999
through June 30, 2000, in the following three campus-based programs:

Federal PerkinsLoan
Federal Supplemental Educational Opportunity Grant (FSEOG)
Federal Work-Study (FWS)

You will receive and transmit your FISAP information to ED viathe Title 1V Wide
Area Network (WAN) network using your EDconnect software.

Using This Installation Guide

Use the ingtructions contained in this Installation Guide to install the software on
your computer or local area network (LAN). Seethetopic Installation Instructionsin
thisguide for installation information.

This guide a so provides you with hardware and software requirements, LAN
compatihbility issues, and how to get help.

FISAP for Windows
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Help

Instead of a paper user’s guide, FISAP for Windows has online help. General helpis
available from the menu bar and field help is available by pressing the F1 key. From
the menu bar, sdect Help, Using Help for more information.

FISAP Customer Support can be reached by telephone at:
1-800/330-5947

or by email at:
CPS@NCS.COM

See the topic CPS Customer Service in the online help and this Installation Guide for
more information.
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System Requirements

Hardware and Software Requirements

The following hardware and software are required for FISAP for Windows:
IBM or fully IBM-compatible PC with a 486D X2 66 MHz processor or better
16 MB total memory or more

300 MB of available hard disk space (depending on the functions you use and
how many records you store in your database)

3.5" high-density floppy disk drive

Microsoft compatible mouse

Hewlett Packard (HP) LaserJet compatible printer.

MS-DOS version 6.2 or higher (unless using Windows 95 or Windows NT)

Microsoft Windows version 3.1, Microsoft Windows for Workgroups 3.11,
Microsoft Windows 95, or Microsoft Windows NT 4.0 or above

=  Consider aquad-speed (or better) CD-ROM drive for other future software
distributions

= Consider atape backup system to store your data

= Monitor and video card capable of standard VGA (800 x 600) resolution (small
fonts only). FISAP for Windows was designed in super VGA. You may use a
higher resolution than super VGA at your own discretion.

Estimating Hard Disk Space

The following information gives you an estimate of how much hard disk space is
required for each ED software product and for certain types of records.

To find out the approximate total space required, add together the amounts shown for
each ED-software product and the types of records you are using. Y ou should also
take into account other software products installed on your PC.
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Example:

Thetotal space required for 5,000 Direct Loan, ISIR, NSLDS, and Packaging
records using all of the software products listed is approximately 70 MB.

Each software product requires the following space:

with 300 records

Product Size
EDconnect/NET* CONNECT for Windows | 15 MB
EDExpress 16 MB
FISAP for Windows 4MB
SSCR-32 with 300 records 6 MB
Quality Assurance Program for Windows 2MB

Additional space required per set of 5,000 records (this is in addition to
the values listed for the software listed on the previous page):

Record Size
Direct Loan 6 MB
ISIR 15MB
NSLDS 4MB
Packaging 2MB

4 . Installation
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Local Area Network (LAN) Server
Compatibility

LAN Server Compatibility

FISAP for Windows can be used as stand-alone or multi-user software. It can be run
on the following network operating systems:

Novell Netware 3.x and 4.x
Microsoft Windows NT Server

Users should not run the software on peer-to-peer networks such as Arisoft
LANTtastic or Novell’s Personal Netware.

According to the Microsoft Knowledge Base, some anomalies have been known to
occur when using Microsoft Access with the following networks: DEC Pathworks,
IBM Lan Server, and Sun PC-NFS. Since FISAP for Windows makes extensive use
of Microsoft Access as a database engine, do not use these network operating
systems with FISAP for Windows.

LAN Cautions

When multiple users are concurrently updating databases in the FISAP for Windows
database, those tabs are locked. Also, certain functions are locked when concurrent
access would degrade the system or disrupt a process.

Examplesinclude:
The database is locked when the executing function is mass loading records.

Records are locked when an executing function needs stable data for updating or
printing.

Functions are locked when multiple executions of the functions would destroy
the databases.

FISAP for Windows
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LAN Messages
These messages notify users when a locking situation occurs.
LAN Error Message
Condition
<Database> is locked and cannot be accessed at this time.

If the database remains locked after five seconds of continual attempts, the user is
returned to the menu bar or to the point prior to execution.

Record in use - Retry later.

If the record remains locked after five seconds of continual attempts, the user is
returned to the menu bar or to the point prior to execution.

Function in use - Retry later.

If the function remains locked after five seconds of continual attempts, the user is
returned to the menu bar.

See the topic Clear Record Locksin the online help for more information on this
subject.

Additional LAN Instructions

From the Netware Server Console prompt, you should enter the following command:
Set Maximum Record Locks Per Connection = 10000

Thisline should aso be added to the AUTOEXEC.NCF file on the NetWare server.
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LAN Hardware and Software Recommendations

IBM or fully IBM-compatible PC with a 486D X2 66 MHz processor or better
16 MB total memory or more on each workstation

300 MB available hard disk space on thefile server (depending on the number
of records you will storein your database)

MS-DOS version 6.2 or higher (unless using Windows 95 or Windows NT)

Desktop Operating System: Microsoft Windows versions 3.1, 3.11, Microsoft
Windows for Workgroups 3.11, Micraosoft Windows 95, and Mi crosoft
Windows NT 4.0 or above

Network Operating System: Novell NetWare versions 3.12 or above or 4.11 or
above, Microsoft Windows NT 4.0 or above, or Microsoft LAN Manager

Note: Novell NetWare versions 3.12 and 4.11 are separate products.

16 megabit/sec transfer rate on the network for token ring, 10 megabit/sec
transfer rate on the network for Ethernet, or the maximum transfer rate your
network topology supports

Monitor and video card capable of standard VGA (800 x 600) resolution (small
fonts only). FISAP for Windows was designed in super VGA. You may use a
higher resolution than super VGA at your own discretion.

Note: For questions regarding any of the listed hardware or software
requirements, please contact CPS Customer Service at 1-800/330-
5947.

FISAP for Windows
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Installation Instructions

Installation Process

This section of the Installation Guide provides you with step-by-step instructions for
ingtalling FISAP for Windows. Instructions are provided for both network and stand-
alone system installation.

Depending on the type of install you are performing (network or stand-alone), all
installation diskettes may not be required.

Other topics include:
Install Log creation
AUTOEXEC.BAT, CONFIG.SYS, and NET.CFG statements
Uninstall instructions
How to change your Swap File settings
Follow the prompts the software provides you when installing FISAP for Windows.

Directory Creation

FISAP for Windows isinstalled to the EDExpress for Windows 1999-2000 program
group. Theinstallation process automatically creates the directory FISAPO for
FISAP for Windows files on your local hard disk.

The C: driveis assumed to be the drive | etter of your local hard disk, but you can
changethe drive letter if necessary. Also, you can use a different name for the
directory.

If you areingtalling on aLAN, be suretoinstall toaLAN drive and not to alocal
drive.
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Installing FISAP for Windows on a Network

Be sure that all Windows applications, including screen-savers, e-mail notifiers, etc.
have been closed before you proceed with this setup.

When you perform a workstation installation, the executable file for FISAP for
Windows (FISAP.EXE) ingtalls to a workstation’slocal hard drive. The installation
modifies all FISAP for Windows program group iconsin your Windows Start Menu
folders to point to the executable on your local hard drive.

Ingtalling thisfile to the workstation’ s hard drive rather than the network file server
improves the speed and performance of the software because FISAP for Windows
uses the combined resources of the workstation and the file server instead of those of
thefile server alone.

Follow the instructions below to install FISAP for Windows on local area networks.

Instructions for Schools that Already Have FISAP
for Windows Installed on a Network File Server

1. Do not usethe Network Server installation option for thisversion of the
software.

The Networ k Server installation option is now only for usersingtalling FISAP
for Windows to a network file server for the first time. Choosing thisinstallation
option installs an empty FISAP9.MDB (FI SAP database files) on the network
file server, overwriting any existing database.

2. Do Full workstation installations on all workstationsfor thisversion of the
softwar e.

Choose the Networ k Wor kstation installation option, then select Full. The Full
option ingtalls the executablefile (FISAP.EXE) in alocal hard drive directory. It
also establishes the workstation’s ODBC (Open Database Connectivity)
connection to the FISAP database. The Workstation installation option prompts
you for the location of the database installed during the FISAP Network Server
installation.

If you have questions, please call CPS Customer Service at 1-800/330-5947.

10 - Installation
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Instructions for Schools that Are Installing FISAP
for Windows on a Network for the First Time

1. First, usethe Network Server installation option toinstall thisversion of the
softwar e. This aption installs only the FISAP database (FISAP9.MDB) on the
file server, not the FISAP program files.

2. Then, do Full workstation installations on all workstations for thisversion
of the softwar e. Choose the Networ k Wor kstation installation option, then
select Full. The Full option installs the executable file (FISAP.EXE) in alocal
hard drive directory. It also establishes the workstation’s ODBC (Open Database
Connectivity) connection to the FISAP database. The Wor kstation installation
option prompts you for the location of the database installed during the Network
Server installation (step 1).

If you have questions, call CPS Customer Service at 1-800/330-5947.

Instructions for All Schools

If you want to copy theinstallation diskettes to afile server so you can do
workstation install ations from the server, follow these steps.

1. Createadisk directory for each diskette received. For example, if you receive
five diskettes, then create five directories on the file. Create a directory structure
like this one on your server.

Example:

\Install

\Instal\DISK1

\Instal\DISK 2

\Instal\DISK3

\Instal\DISK4

\Instal\DISK5

Note: The parent directory can have any name, but the subdirectories must be
named DISK1, DISK2, etc.

Copy the contents of each disk into its corresponding directory on the server.

3. You can now install FISAP for Windows from the file server by running
SETUP.EXE from the DISK1 directory on the server instead of carrying the
diskettes to each workstation.

If you have questions, call CPS Customer Service at 1-800/330-5947.
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Installing FISAP for Windows on a Stand-Alone System

Be sure that all Windows applications, including screen-savers, e-mail notifiers, etc.
have been closed before you proceed with this setup.

Microsoft ODBC (open database connectivity) Setup will fail if any of these
applications are still running.

You can ingtall FISAP for Windows using one of three options:

Full. Use this option when you are installing FISAP for Windows for the first
time It overwrites all existing database (*.M DB) and program files (*.EXE
files) in your FISAPO directory.

Warning: Use caution when using the FULL ingtall option. The
program will remove/erase ALL your existing FISAP database
(*.MDB) and program files (*.EXE files) in your FISAPO
directory.

Upgrade. Usethis option only if you have already installed a full version of
FISAP for Windows for this processing cycle. This option updates only program
files (*.EXE files) and leaves your current database intact.

Custom. If you have already installed a full version of FISAP for Windows for
this processing cycle, you can use this option to replace executable program
files, ODBC files, HELP, and/or the FISAP database. This option leaves all
other system settings intact.

You can reset the FISAPADM user ID and password during a Custom
ingtallation. Click Update Database as the component you want to install.
Then, the first time you use FISAP for Windows after performing the Custom
installation, you will seethe Update Database box. Click Reset
FISAPADM.

Windows 3.1 or 3.11

o~ w D

6.

Turn on your computer and start Microsoft Windows.
Insert Diskette #1 in the A: drive.

Select File from the Windows Program Manager menu bar.
Select Run from the File pull-down menu.

Type a:setup at the command line and click OK. The softwareisinstalled to
the default directory C:\FISAPO unless you choose another |ocation.

Insert diskettes in numerical order and click OK when prompted.

FISAP for Windows asks you a series of questions during the installation. Each
guestion has a default answer.
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If the default is correct, click Next in response to each question.
or

If not, type the correct answer and click Next.

When it isfinished installing the files for FISAP for Windows, the installation
program adds the icons to your Program Group in the EDExpress for Windows
Program Manager window.

Windows 95 or Windows NT

Turn on your computer and start Microsoft Windows.
Insert Diskette #1 in the A: drive.

Select Start from the Task bar.

Select Run from the Start pop-up menu.

o w DN PR

Type a:\setup at the command line and click OK. The softwareisinstalled to
the default directory C:\FISAPO unless you choose another |ocation.

6. Insert diskettesin numerical order and click OK when prompted.

FISAP for Windows asks you a series of questions during the installation. Each
guestion has a default answer.

If the default is correct, click Next in response to each question.
or

If not, type the correct answer and click Next.

When it isfinished installing the files for FISAP for Windows, the installation
program updates your Start menu. It will not, however, create desktop
icong/shortcuts or update them if they have already been created.

FISAP for Windows
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Install Log

Each time an installation is performed, an Install Log is created. The information that
will be tracked is the product and version number, type and nature of the install,
drive/directory, date, and time of install. Thisfileisnamed INSTALL.LOG and is
located in your C:\FISAPO directory.

Example:

<APP NAME> FISAP for Windows
<VERSION> 1x

<TYPE> FULL: Ingtall everything.
<SUMMARY > New release for ‘99-00 cycle
<TARGET> C:\FISAPO

<DATE> 08-19-98

<TIME> 08-36-54

AUTOEXEC.BAT, CONFIG.SYS, and NET.CFG

The software can modify your CONFIG.SY Sfiles automatically. If you do not want
FISAP for Windows to modify thisfile, select the appropriate option and click Next.

To modify your CONFIG.SY Sfile independently at alater time, add these
statements to your file:

Files =120 (or greater than 120)
Buffers = 32 (or greater than 32)

If you are running FISAP for Windows on a Novell Server, then your NET.CFG file
should contain the following statement:

File Handles =120 (or greater than 120)
For Windows 3.1 and 3.11 Users

For Windows 3.1 or 3.11 users, FISAP for Windows will ingtall the VSHARE.386
fileif thefileisnot present. The VSHARE.386 filewill be set up in the
SYSTEM.INI (386 Enhanced) fil€' s section.

Note: Remember to reboot your computer when done.
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Uninstall

After you haveinstalled FISAP for Windows, you will see an Icon for the Uninstall
utility. By double-clicking on Uninstall, the utility deletes al icons, all executable
files, all DLLs, and the entire database for the version of FISAP for Windows you
haveinstalled. If FISAP for Windows isingtalled on a LAN, the Uninstall utility will
only delete the FISAP for Windows icons.

To uninstall FISAP for Windows:
1. Double-click on the Uninstall icon.

A prompt asksif you are sure that you want to completely remove the
application and all of its components.

2. Click theYes button.
3. Click OK.

Changing Your Swap File Settings

Windows 3.1 or 3.11 uses swap files to improve the way your computer uses
memory while you are in Windows, which in turn improves system performance.
Swap files can be temporary or permanent. For maximum performance from FISAP
for Windows, your swap file setting for Windows should be set for a permanent
swap file and use 32-bit disk access (also 32-hit file access if running Windows for
Workgroups 3.11). For simplicity, users can also select a temporary swap file.
Before you install FISAP for Windows, you should review your swap file setting.

To change your swap file setting to Temporary from the Windows
Program Manager:

1. OpentheMain group or the group where your Control Panel icon islocated.
2. Double-click the Control Panel icon.

3. Double-click the 386 Enhanced icon.
4

Click the Virtual Memory button. Look at Typeto seeif your swap fileis
currently set to Permanent (using BIOS) or Temporary (using MS-DOS).

o

If the setting is Temporary (using MS-DOS), click OK until you return to the
Program Manager window. Y ou are ready to install FISAP for Windows.

6. If the setting is Permanent (using BIOS), continue with step 7 below.

7. Click the Change button.

8. Clickthedown arrow in the box next to Type and sdlect Temporary.
9. Click OK.

10. Restart Windows and proceed with installing FISAP for Windows.

FISAP for Windows Installation - 15



To change your swap file setting to Permanent from the Windows
Program Manager:

1

2
3.
4

o

© ®©® N o

Open the Main group or the group where your Control Panel icon islocated.
Double-click the Control Panel icon.
Double-click the 386 Enhanced icon.

Click the Virtual Memory button. Look at Typeto seeif your swap fileis
currently set to Permanent (using BIOS) or Temporary (using MS-DOS).

If the setting is Permanent (using BIOS) and 32-hit disk access (also 32-hit file
access if using Windows for Workgroups) is checked, click OK until you return
to the Program Manager window. Y ou areready to install FISAP for Windows.

If the setting is Temporary (using MS-DOS), continue with step 7.
Click the Change button.
Click thedown arrow in the box next to Type and sdlect Permanent.

Check the box next to 32-bit disk access (also check 32-bit file accessif using
Windows for Workgroups).

10. Click OK.
11. Restart Windows and proceed with installing FISAP for Windows.
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Getting Started

Logging In for the First Time

Each time you start FISAP for Windows, you must enter avalid user ID and
password. FISAP for Windows requires user I1Ds and passwords for system security.

Thefirst time you use FISAP for Windows, enter FISAPADM for both your user ID
and password. FISAPADM isthe user ID and password included with FISAP for
Windows. Y ou will then be prompted to enter a new user 1D and password.

Follow these stepsto log in to FISAP for Windows for the first time.
To log in and establish your new user ID and password:

1. Thefirst timeyou use FISAP for Windows, enter FISAPADM for both your
user ID and password.

FISAPADM isthe user ID and password included with FISAP for Windows.
2. PressEnter or click OK.

You will be prompted to enter anew User ID and Password.

Press Enter or click OK.

On the next screen, enter a New User ID, Password, and Verify password.

= Upto eight (8) alphanumeric characters may be entered.

=  ThePassword and Verify Password must be the same.
5. PressEnter or click OK.

FISAP for Windows will indicate that the updates have been saved.
6. PressEnter or click OK.

After you enter your user ID and password, a message box may display any
messages, warnings, or errors.
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Getting Help

Review Installation Instructions

Review the ingtallation instructions again. Seeif you perhaps | eft out a step. Try the
installation process again.

Become Familiar with Your PC

Display your system information such as your AUTOEXEC.BAT file,
CONFIG.SY Sfile, and memory information. Refer to your MS-DOS or MS-
Windows manual for instructions.

If you have completed the FISAP for Windows installation, click System
Information from the Help menu. Compare this information to the required
configurations listed at the beginning of this section. Y ou may need to upgrade your
equipment or change your files.

Y ou may also want to run Microsoft’s System Diagnostic (M SD.EXE) program.
Refer to your MS-DOS manual for instructions.

Contact Your System Administrator

Your ingtitution or organization may have additional instructions for your PC. For
example, you may get an error if you aretrying to install the softwareto adrive for
which you do not have access.

FISAP for Windows Online Help
Using Help issimple. You can get help by any of the following methods:

1. FromtheHelp menu, choose a help command.
2. Choose the Help button available in many dialog boxes.

3. Usethe keyboard to select an item on amenu, and then pressF1 to seea
description of the item.

4. Sdect adialog box option or command, and then press F1 or click the Help
button to move directly to an explanation of the option.

5. Usethe Context Help Toolbar button to obtain help on menu options and
other Toolbars.
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Using Windows 3.1

Complete the Windows tutorial that comes with Windows 3.1. To access this
tutorial, follow the steps listed bel ow:

1

2
3.
4

Select File from the Windows Program Manager menu bar.
Select Run from the File pull-down menu.
Click the Browse button.

Highlight wintutor.exe and click OK. You will seethisfile displayed in the
Command line.

Click OK.

Using Windows 95

Windows 95 comes with an online tour that describes how to use Windows 95. To
access this tour, follow the steps listed bel ow.

o M DR

Select Start from the Task bar.

Select Help from the Start pop-up menu.

Select the Contents tab.

Highlight Tour: Ten minutes to using Windows.
Click the Display button.

FISAP for Windows
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CPS Customer Service

If you need technical support, call CPS Customer Service at:
800/330-5947

Representatives are available to assist you between 7 am. and 7 p.m. (CT), Monday
through Friday, excluding holidays.

You may also send your inquiries viathe Internet to CPS at:
CPS@NCS.COM

The CPS Voice Response System has phone routing set up to assist you in
designated areas. When you call 800/330-5947, you will be asked to enter the last 5
digits of your Title V WAN User ID.

Example:

For TG50001, enter 50001

For TG60001, enter 60001
You will then be presented with a menu of options.

Choose the area appropriate to the information or assistance you need:

Menu Option Description

1 CPS Automated Customer Service Center is an automated
system through which you can check the status on batches
and applications, request faxable materials and information,
and obtain other needed data, such as reject, comment, and
assumption code definitions.

2 Application Processing — Representatives assist you with
installation and software questions.

3 Direct Loan — Representatives assist you with installation and
software processing issues.

Representatives also assist you with questions on the Direct
Loan Technical Reference.

4 Pell Payment — Representatives assist you with installation
and software questions.

5 SSCR - Representatives assist you with installation and
software questions.

6 Quality Assurance Program for Windows —
Representatives assist you with installation, software, and
program guestions.

7 Packaging — Representatives assist you with installation and
software questions.

8 FISAP for Windows — Representatives assist you with

installation, software questions, and technical issues.
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When you call CPS Customer Service, you should be at your computer and prepared
to provide the following information:

The version of FISAP you are using (under Help/About ...).

The type of hardware/network you are using (including total RAM, version of
Microsoft Windows, other running applications, LAN type if applicable,
available disk space, type of memory management being used, etc.).

The exact wording of any error messages you have received, as they appeared
On your screen.

A detailed description of the utility or function you were running when the error
occurred, what software module or package you were working in (Application
Processing, Packaging, Direct Loan, Pell, FISAP, QAP, or SSCR-32), and the
steps you took to get to that utility or function.

A description of any resolution steps you took prior to calling.

FISAP for Windows
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